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Introduction 


The Arma CNC Tube Notcher kit contains hardware components, electronics and software to 
be used with a customer fabricated steel rail and frame made along with a customer supplied 
computer, plasma torch, air compressor and water trough. 


The assembled CNC Tube notcher automates fabrication of metal tubing and pipe with coping 
for joints, tabs and slots for alignment and is compatible with the Arma Tube Bender allowing 
for notched, tabbed and slotted bent tubing fabrication from CAD models. 


The CAD CAM software Arma Design Studio (ADS) has support for modelling tubing, auto 
notching intersections, auto tab slots and bending with GCode export and machine control. 
ADS also has import functions to take geometric cad models from other software and generate 
GCode notching instructions. 


The tube notcher kit requires the purchase of additional metal and a fabricator to assemble a 
frame and rail for the kit to attach onto. The kit also requires a computer to operate the 
machine, a plasma torch and air compressor.  


The Arma Tube Notcher is ideal for fabricators building round tube structures such as vehicle 
chassis, roll cages, bumper cages, truck racks, etc.  





Illustration: Assembled Arma CNC Tube Notcher Kit Fully Assembled.  
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Illustration: Prototype development cutting test tube parts. The kit parts are different.

 

Illustration: Early prototype test parts. Calibrated notches and cuts are cleaner.
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Specifications 

The tube notcher supports the cutting of Steel and Aluminum round tubing and pipe with an 
outer diameter between 1” and 2”. 


Wall thickness up to 3/8th inch is supported. 


Square tubing is not supported by this product. 


Two axis positioning and cutting is supported. The torch cutter is always positioned 
perpendicular to the tube surface as the tube rotates and the torch travels along the length. 
This means that there may be a wedge shape that needs to be welded on coped joints 
especially for tubing with a thick wall. 


The maximum supported length of tube and pipe is flexible as the length of the frame and rail 
can be customized during assembly. The reference notcher is 14’ wide supporting tubing with 
a maximum length of 12’. The notcher can be made smaller to accommodate confined 
workspaces and lengthened to cut full length tubes 24’ long. 


Control software in the Arma Design Studio application supports fabrication with new model 
designs or existing third parts cad models imported. 


Optionally a Mach3 compatible controller solution can be provided for customers wishing to 
use Mach3.


Environment 

A dry workspace is required with a floor space area of 4 feet by 14 feet and optionally up to 26 
feet for extended models.


Power outlets of 220 volts with 40 Amps are required for the plasma torch and a 110v 
receptacle is required for the control electronics and operating computer.   


Adequate ventilation is required near the plasma torch as fumes are produced during cutting.
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Target Applications 

The Arma CNC Tube Notcher is intended to be an affordable automation tool for individual 
builders, medium sized business and industrial manufacturers. 


Complex tube structures can be modelled in CAD software and fabricated in an efficient, 
accurate and repeatable manner. 


Tube structures can be cut with coping edges for accurate fitment to connecting tube where it 
can be welded in place. 


The Arma Design Studio CAD/CAM software can generate notch profiles for intersecting tubes 
with tabs in one part and corresponding slots in the connecting part. This aids in verifying 
alignment as tubes can only fit together in the correct location as well aiding in assembly where 
the tabs hold parts in place more easily resulting in less jig scaffolding for complex projects.




Illustration: Example notch with tabs and corresponding alignment slots. 
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The CNC Tube Bender was designed for projects like the Arma vehicle chassis made from a 
space frame tube structure using notches, tabs and slots to reduce the alignment jig structure 
requirements and complex bends for better space constraints as well as appearance.


Illustration: Example project - The Arma vehicle chassis. 

Notched parts are compatible with the Arma CNC Tube Bender allowing CAD models of tube 
structures with bends to be cut using the Arma CNC Tube Notcher and then placed in the 
bender to produce complete parts ready for assembly.




Illustration: Optional Product - Arma CNC Tube Bender is compatible with the CNC Tube Notcher. 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The acquisition cost for a complete bender system:  


Operational cost projections:


Component Price Reference

Notcher Kit $5,000.00 CAD armaautomotive.com/tools/tubenotcher/

Plasma Torch $1,000.00 CAD est. CNC compatible

Metal Frame & Rail $1,000.00 CAD est. Local sourced material cost

Assembly & Welding $1,000.00 CAD est. Local contractor cost

Air Compressor $600.00 CAD est. Local purchase

Computer $500.00 CAD est. Windows XP, Mac OSX, Linux with USB

Total $9,100.00 CAD est.

Operation Time Cost

Single notch - Human operator: measure + 
notch + fitment check

8 Minutes est. 1 Notch = $3.33 @ $25/hr

One year human operator 7 hours per day. 12,600 notches = 
$42,000 / year

Single notch - Arma CNC Tube Notcher: 
load material + monitor operation.

2 Minutes est. 1 Notch = $0.83 @$25/hr

One year Arma CNC Tube Notcher - Time 
savings.

1.75 hours per day
 12,600 notches = 
$11,200 / year

One year Arma CNC Tube Notcher - 
Increased production.

7 hours per day. 50,400 notches = 
$42,000 / year

Yearly productivity comparison. 4X Gain. $30,800 Savings or 37,800 
more notches per year.

Return of capital @1 hour per day 45 minutes per day saved 2 Years to return.

Return of capital @2 hours per day 1.5 hours per day saved 1 year to return.

Return of capital @3 hours per day 2.25 hours per day saved 8.6 Months to return.

Return of capital @4 hours per day 3 hours per day saved 3.1 Months to return.
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Workflow  

Illustration: Options for software compatible with the notcher workflow. 

The Arma CNC Tube Notcher can be used with a wide variety of control hardware and design 
and manufacturing software. 


Some hardware options available to control the notcher are software specific and need to be 
ordered or configured based on your preferred software. 


If you do not already have CAD and control software licenses you can use the Arma ADS and 
control software as they are designed to work in a streamlined workflow.  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Kit Contents  

Gantry trolly: 1 Piece 


The gantry holds the plasma torch head and rolls along the rail length. The torch has a cable 
that needs to be suspended so that it doesn’t catch. A ventilation duct should be added to the 
torch head to pull out smoke when cutting. 
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Chuck Assembly: 1 Piece


The chuck assembly bolts to the frame and holds the loaded tubing to be cut as it rotates. 
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Tube Stays: 8 Pieces


The tube stays hold loaded tubes centred with the chuck so that they can be rotated. The arms can 
carry a 1” diameter tube up to 2” in diameter. The base should be tack welded to the rail and the upper 
portion can be replaced or upgraded.
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Chain Stay: 2 Pieces


The chain stays hold the chain in place for the gantry trolly to pull against as well as limit 
switches that shut off the machine before the trolly moves into one of the ends on the machine.
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Gantry Tensioner: 3 parts


The gantry tensioner adds stability to the gantry rail and allows for alignment adjustability in 
case the gantry needs to be straightened.
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Casters: 4 Pieces


Plates are to be welded to the frame and caster wheels bolted on. Casters allow the notcher to 
be moved and each leg height adjusted in a fixed position for stable operation.
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Plasma Torch Tray: 1 Piece


The torch tray mounts to the frame and holds the plasma torch off of the ground so that the 
torch cable can reach from side to side.
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Water System: 1 Set


The water system pumps water from the catch tray through a filter and between the chuck so 
that it flows through the tube. Water flowing through the tube as it is being cut prevents cut 
through and material from sticking to the inside of the tube.
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Controller Box: 1 Piece


The control box connects a computer with CAD / CAM instructions and drives the stepper 
motors, limit switches and torch connectors. The controller is available based on two different 
hardware options, one with a Mach3 compatible version that works with the Mach3 control 
software and the other with the Arma Controller compatible system. 
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Wiring harness: 1 Piece


The wiring connects the control box to two stepper motors and the plasma torch activation 
signal and limit switches. Optional connectors for a tube sensor and hood vent switch are 
available on the Arma Controller currently under development.


Chain: 1 Piece.


The chain spans the length of the rail and allows the gantry trolly to advance. The chain needs 
to be ordered with a length long enough to span the rail which can be longer or shorter than 
the reference fourteen feet.

 


Software: ADS (CAD/CAM/Control) Website download.


A copy of ADS and an accompanying hardware controller program is provided for modelling or 
importing CAD models to generate GCode files which instruct the notcher how to cut parts. 


Updates to the software will be available from the Arma Automotive Inc. website.
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Additional Required Hardware


Steel Tubing: 

6X 168 Inch length 1.75” x 1.75” 0.064” wall thickness square tubing. 

4X 36 inch length 1.75” x 1.75” 0.064” wall thickness square tubing.  

3X 22 inch length 1.75” x 1.75” 0.064” wall thickness square tubing.

4X 28 inch length 1.75” x 1.75” 0.064” wall thickness square tubing.

12X 4.125 inch length 1.75” x 1.75” 0.064” wall thickness square tubing.

2 Pieces 14 feet length 1” x 1” L channel mild steel.

8x 5 inch 1” OD 0.095 Wall mild steel tubing.

1x 156” Length 1” OD 0.095” Wall mild steel tubing.


Water Trough:  


A water trough catches water as it runs out the end of the tube so that it can be collected and 
pumped again.
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Plasma Torch: 


A customer supplied plasma torch is required for cutting. A torch with a remote activation 
switch is recommended so that the control electronics can start and stop cuts during 
operation. If your plasma torch does not have a remote activation switch a relay circuit will be 
required.


Air Compressor: The plasma torch will require a source of compressed air. The torch will have 
a minimum requirement. 


Power Outlets: The plasma torch will require a 220v receptacle with enough capacity to 
operate the torch. 40 Amps is the reference value. The control electronics require a 110v 
receptacle with a maximum draw of 150 watts.   


Computer: Capable of running Windows XP, Mac OSX, Linux with a USB port.


Ventilation: Adequate ventilation is required near the plasma torch as fumes are produced 
during cutting.


Welder:  A welder is required for the assembly stage of the installation.
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Safety Warning 

Eye Protection 


When operating the CNC Tube Notcher ensure that anyone in line of sight to the plasma torch 
arc wear protective eye wear. The bright light and flying ambers can cause eye damage without 
adequate protection.   


Gloves 


When loading and unloading metal tubing and piping from the notcher wear protective gloves, 
shoes and clothing as metals can be heavy with sharp edges and can cause injury if handled 
improperly. 


Electrical 

Ensure that adequate power is available to the plasma torch and that the working environment 
is dry with adequate ventilation free from flammable gasses and fumes. 


Water 

The Arma Tube Notcher uses circulating water pumped through the length of tubing to be cut 
to cool and prevent cut through on the opposite side. Ensure that there are no water leaks or 
electrical wires in the water system. 
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Assembly Instructions 

Cut the mild steel square tube with a size of 1.75” x 1.75” to the dimensions illustrated in the 
following drawings. Larger scale versions are available on request.
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Casters 

Weld each of the four caster plates to the frame and assemble the casters with pictured bolts, 
washers and nuts. 
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Chuck Assembly 

Drill holes through the frame at locations matching the chuck assembly mount holes. 


Install the chuck assembly to the frame using bolts, washers and nuts as shown.


Lock washers between the frame and the chuck assembly can be used to align the chuck so 
that the axis of rotation matches the frame stays. 
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Gantry 

Install the gantry to the frame rail and feed the drive chain through the sprockets 





Illustration: Gantry assembly front view. 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The gantry sits behind the frame rail resting on two roller bearings on top and one spring 
loaded bearing on the bottom. The lower bearing arm will need to be pulled down for 
assembly.





Illustration: Gantry on frame rail rear view. 
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A spring holds the lower rail bearing against the rail. 





Illustration: Gantry lower bearing arm and spring. 
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Chain Stays 

Drill and assemble the left chain stay and gantry limit switch using the illustrated bolts, washers 
and nuts to the main frame.  


 

Illustration: Left chain stay bolted to the main frame on the outside. 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Drill and assemble the right side chain stay and gantry limit switch using the illustrated bolts, 
washers and nuts to the main frame.





Illustration: Right chain stay bolted to the main frame on the outside. 
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Steady Rests 

Slide on the steady rests to the one inch tube on the main frame. Space the stays equal 
distance apart from each other and align angles and centre line so they are all positioned along 
a straight line. Tack weld one or two spots to hold the base of the stays positioned.  





Illustration: Install the stays onto the main frame. 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Illustration: Place a tube in the chuck to align the stay angles and positions before welding. 
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Electrical 


Electronics are used to connect a computer to stepper motor drivers which operate the 
machine as well as activate and deactivate the plasma torch. Several options for electronics 
are available including widely available Mach 3 control boards that works with the Mach 3 
control software.  


Arma Controller 

Arma Automotive Inc. Is working on control software and hardware for operating the CNC tube 
notcher with features for operating hood fans and reporting on machine status remotely 
however this product is currently not finalized and we recommend using Mach 3 as the control 
software and electronics at this time.


Mach 3 Controller 

Mach 3 controllers and stepper motor drivers can be used to operate the Arma CNC Tube 
Notcher to cut tubes and pipe from GCode generated from ADS or other Cad and Cam 
software. 


The Mach 3 controller connects to a computer through a usb cable, 24v power, torch trigger 
and ground to the plasma torch, two input switches for the gantry limits and seven wires to 
each of the two stepper motor drivers. 


Mach 3 Stepper driver wiring:

Mach 3 controller: X Pulse -> Stepper driver 1 Signal PUL +.

Mach 3 controller: Ground -> Stepper driver 1 Signal PUL -.

Mach 3 controller: X Dir -> Stepper driver 1 Signal DIR +.

Mach 3 controller: Ground -> Stepper driver 1 Signal Dir DIR -.

Mach 3 controller: 5v -> Stepper driver 1 Signal ENA +.

Mach 3 controller: Ground -> Stepper driver 1 Signal ENA -.


Mach 3 controller: Z Pulse -> Stepper driver 2 Signal PUL +.

Mach 3 controller: Ground -> Stepper driver 2 Signal PUL -.

Mach 3 controller: Z Dir -> Stepper driver 2 Signal DIR +.

Mach 3 controller: Ground -> Stepper driver 2 Signal Dir DIR -.

Mach 3 controller: 5v -> Stepper driver 2 Signal ENA +.

Mach 3 controller: Ground -> Stepper driver 2 Signal ENA -.


Stepper motor wiring:

B-  -> Black stepper motor wire.

B+ -> Green stepper motor wire

A-  -> Red stepper motor wire.

A+ -> Blue stepper motor wire.

VCC -> 24 V power supply.

GND -> Power supply ground.


Page 36



Torch Wiring:

Mach 3 controller: OUT 1 terminal to the torch trigger signal pin. 

Mach 3 controller: GND terminal to the torch trigger ground pin.


Limit switch Wiring:

Mach 3 controller: IN 1 to the right hand side limit switch pin 1.

Mach 3 controller: 5v to the right hand side limit switch pin 2.

Mach 3 controller: IN 2 to the left hand side limit switch pin 1.

Mach 3 controller: 5v to the left hand side limit switch pin 2. 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Notcher Setup 

Power 


The CNC Tube Notcher requires power to operate the electronics and stepper motors as well 
as a V220 receptacle for the plasma torch.


Water 


Water is used in the tray and pumped through the tube to prevent accumulation of splatter. Be 
sure that water does not leak near electrical power.


Torch tip replacement 

The torch tip will require replacement after use. 


Cut tubes to length 


If tubes are longer than the maximum supported length of the notcher they will first need to be 
cut.


Load tubes in machine 

Tubes should be placed in the frame stays and chuck before being tightened securely.


Remove cut parts and clean up edges. 

After parts are cut they will fall into the water tray. Wait for the machine to stop and carefully 
remove cut parts with safety gloves.  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CAD Modelling with Arma Design Studio 



Illustration 6: Arma Design Studio CAD/CAM software application. 

Getting started with Arma Design Studio 

ADS runs on Windows, Mac OSX and Linux. 


Download from: http://armaautomotive.com/build/ads.php


There are download links for Windows and Cross Platform that will run on Windows, MacOSX 
and Linux with Java.


See the appendix for a tutorial on the basic navigation and operations of ADS.


The version of ADS documented in this manual is 1.1.37 Released Marc 23, 2022. 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Windows 
 

Extract the file contents and double click the ArmaDesignStudio.exe application. 

The Windows version is currently not signed so a dialog will appear. Click on the More info link.
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Click on the Run anyway button.


Cross Platform 

Download a Java Runtime. 

- Oracle links https://www.java.com/en/download/manual.jsp

- Mac M1 based Macs will run with the runtime from Azul: https://www.azul.com/


Extract the zip file and ArmaDesignStudio.jar


In a terminal window navigate to the extracted files Adssrc directory and type the command:


> run.sh
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Notch Cut Profile Modelling


Tubes are modelled in Arma Design Studio using the ArcObject which has attributes for tube 
diameter and wall thickness. Geometric polygonal tubes can also be used but lack certain 
features. 

 

Notch cuts are modelled on tubes using either a polygon or curve object placed as a children 
in the object tree list. 
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Modelling Tube Structures 

To add a tube structure to a project click to select the ArcObject from the tool menu then click 
on the scene points for the start location and double click to add the end location.


With the arc object selected update the properties Tube Diameter and Tube Wall. The Bend 
Radius and Min Bend Span apply to parts intended for the Arma CNC Tube Bender and are 
modelled with arc tube objects with more than two points.
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Manual Notch 

Manually add notch cut profiles by selecting the curve tool or polygon tool and clicking points 
on the scene double clicking to end a curve. Selected curve objects can be edited to add /
remove and reposition points to the desired location around the tube. In the object tree list 
drag the notch into the arc tube object as a child. This will cause the notch to be applied to the 
tube when exporting GCode. 


For a detailed explanation of how to add and edit arc objects polygon and curves to the scene 
see the appendix section on getting started with Arma Design Studio.
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Notch Intersections 

Intersecting notch cut profiles can be added by selecting the Auto Notch Tube Intersections 
under the Tools menu. 
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Tabs and Slots 

Select a notch curve and select the Tools menu, Tube Notching, Add Tabs to Notch item. This 
will add tabs to the notch and add slots to the intersecting arc tube. Currently the slots need to 
be checked for possible adjustment as the tube wall thickness is not factored into the size of 
the slot yet. 




Illustration: Selected notch profile and menu item for adding tabs and slots selected.
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The notch object will be modified to add tabs and slots will be added to the intersecting arc 
tube object. This way the cut tubes will fit together but only in the correct location modelled in 
the CAD application. 





Illustration: Notch modified with slots and intersecting slots.  

Page 48



Add or modify tab and slot manually by editing a notch profile, adding points and moving them 
using the Tab Slot Tool into the space of an intersecting tube. This will create a slot curve cut 
profile in the intersecting arc tube. 


Add points as needed to create your tab. Select the tab slot tool at the bottom of 
the curve editor window and use the mouse or keyboard to move a selected set of 
points into the intersecting tube area. 
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Slot cut profiles are added to the intersecting tube.




Page 50



Mirror Planes 

Adding a mirror plane object to an arc centre point will cause any notch profiles to be 
duplicated on the opposite side. This is useful on projects that are symmetrical left to right as it 
ensures that the notch and tab slot profiles are the same.


Add an Arc tube to the scene oriented along the X axis and add a centre point that is 
positioned where you want the mirror duplication to be based from. As a child of the arc tube 
object add a Mirror Plane object so that the start and end points span the Arc centre point. 


Add and edit notch profiles on the arc tube and observe that new notch profiles are added on 
the opposite side. Edits to the duplicated profile geometry will be overwritten if the original 
object is moved or edited.  


Arc objects with a mirror plane object in the centre point will also conform to modifications to 
points on the left hand side such that moving, adding or deleting points will be mirrored across 
the other side.


Page 51



Cut Order


Notch cut profiles need to be ordered so that notches farthest from the chuck are cut first. This 
ensures that all cuts are completed on the tube when it is still attached.
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Scale 

An export scale factor can be set for a file to change the exported units. The default value is 1.


Units in the scene will need to be defined in the control software to map to real world units 
typically inches or cm. 
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Export Arc Notch Cut Profile GCode 

Select an arc object with notch cut profiles and select Export Arc Tube Notch GCode under the 
CAM menu.
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Export tube notch GCode file dialog.


The 360 Degree Width is a notcher machine specific value that maps the radial geometry of a 
CAD model around a tube to a linear value the chuck needs to move so that the notch profile 
spans 360 degrees to complete the notch profile so the end point connects to the start.


The Feed Rate specifies how fast the cutter head is moved when cutting. This value will vary 
depending on the material thickness and composition. Too fast and the torch may not cut 
through the material and too slow might cause warping and larger cut paths. 


The Fast Rate specifies how fast the part is moved when not cutting. This can be faster than 
when cutting. The maximum moving speed depends on the amount of energy available to drive 
the motors and the mass of the moving parts. Too fast an acceleration can cause the stepper 
motors to stall and loose track of the correct positioning.

   


Before cutting parts check the exported GCode part order is correct by reviewing the part 
order section.
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GCode files will be written in the project folder for each part. If a single part is selected the 
GCode will be displayed in a dialog. These GCode files need to be loaded into a controller 
program that will operate the CNC Notcher. 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Importing Geometric Models from Other CAD Applications 

If you use third party CAD applications to model your tube projects you can export models in 
OBJ format and import them into Arma Design Studio and use tools to add notch profiles that 
will be used to generate GCode for the notcher.


If your CAD application can export tube notch profile GCode directly then you do not need to 
use ADS.


Note: If you don’t already have geometric models in another CAD application the 
recommended method for modelling tube based projects in ADS is described in the next 
section. 

Import geometric object files in OBJ or STL file format. 
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Select the imported object and click Add Notches to Tube Geometry under the Tools menu. 
This will add notch profile curves as children of the object.
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Currently the Tube functions only export parts when oriented along the X axis. Tubes modelled 
with the Arc Object to not need to be oriented along any axis and are recommended for new 
designs.
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Cut Order


Notch cut profiles need to be ordered so that notches farthest from the chuck are cut first. This 
ensures that all cuts are completed on the tube when it is still attached to the chuck.







Notches are cut in ascending order, so lower numbers should start farthest from the chuck.  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Export from the CAM menu.
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Export tube notch GCode file dialog.


The 360 Degree Width is a notcher machine specific value that maps the radial geometry of a 
CAD model around a tube to a linear value the chuck needs to move so that the notch profile 
spans 360 degrees to complete the notch profile so the end point connects to the start.


The Feed Rate specifies how fast the cutter head is moved when cutting. This value will vary 
depending on the material thickness and composition. Too fast and the torch may not cut 
through the material and too slow might cause warping and larger cut paths. 


The Fast Rate specifies how fast the part is moved when not cutting. This can be faster than 
when cutting. The maximum moving speed depends on the amount of energy available to drive 
the motors and the mass of the moving parts. Too fast an acceleration can cause the stepper 
motors to stall and loose track of the correct positioning.

   


Before cutting parts check the exported GCode part order is correct by reviewing the part 
order section.  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Control Software  

Control software takes GCode files exported from CAD software and operates the CNC Tube 
Notcher. Arma Design Studio has a control program that works with the Plasma Notcher but 
you can use any control software you like provided you have the hardware that drives the 
stepper motors, activating the torch and input for limit switches.


Arma CNC Notcher Control Software 

To launch the Arma Control Program select the CAM menu item and CNC Machine Control 
menu item.


In the top left of the window is a drop down that lists the connected hardware devices.


Load File will prompt for a GCode file for processing. ADS generates folders with GCode files 
in the same directory the project file resides when running exporting Tube Notch and Arc Tube 
Notch functions.


Stop will halt the torch and any movement of the gantry and chuck as a cut profile is being run.


Test activates a mode where by running the GCode profile will move the gantry and chuck as if 
a notch is being cut but the torch will not activate. This is a good way to check that the start 
and end points line up with the loaded tube and that the order of the notches is correct so that 
no features are missed. Be sure that the notches are cut first from the furthest and away from 
the chuck.
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Live disables the test mode. Running the GCode cut program will move the gantry and chuck 
rotation and activate the torch for cuts. 


Run will start the program from the current selected GCode line.


Progress indicates how far into the GCode file is currently being viewed in the editor or run. 


X Y Z Steps are machine specific values and calibrate the number of pulses to be sent to each 
stepper motor to move a unit of distance, typically one inch. X moves the gantry torch head left 
and right along the rail. Y moves the chuck rotation and units are translated in the GCode to 
unroll to 360 degrees. Z is not currently used in the Tube Notcher. 


The top centre window displays a preview of the GCode cut profiles. This is used to show the 
progress through cuts and to verify patters are correct before cutting material. 


The bottom centre window displays the GCode file contents. Running the program will step line 
by line through the program. Selecting a line will display in the preview where the torch head 
will move too.


In the top right window are X Y and Z values that indicated the numerical unit position of each 
axis the machine is being instructed to move too. The X axis is the gantry width and the Y axis 
is the chuck rotation movement. Z is currently not used in the notcher.


Go To will cause the machine to move the torch head to the input value coordinates.


Set Zero will set the control program coordinates to zero so that the loaded program will start 
from that location.


Movement Buttons jog the torch head left or right and rotation forward and backward manually 
for positioning.
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Mach 3 

The Mach 3 control software can be found on the website ArtSoft.


https://www.machsupport.com/software/mach3/ 
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Appendix 

Getting started with Arma Design Studio 

Loading files 

ADS files have the file extension .ads. Open existing files by clicking Open or Open Recent 
from the File menu.


Download Files will show a few sample model files for demonstration.

Import STL and OBJ file models into the scene using the appropriate Import menu item.


Zooming 

Zoom in and out of the scene by moving the mouse cursor over the view scene window and 
use the mouse scroll wheel or two fingers on a track pad. 


Panning 

Hold the command keyboard key down and left click with the mouse to drag the scene viewer 
area.
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Rotating 

Hold the option keyboard key down and left click with the mouse to drag the scene viewer 
area.


Selecting Objects


Objects in a scene can be selected by clicking on them or clicking on the object list in the right 
side pane.


When clicking on a scene with many objects overlapping the smallest object will be selected 
by default. If this is not the desired object the desired object can be selected by name as listed 
in the selection window on the right hand side under the object list. 


Adding Primitives 


Adding Curves 


Click on the Create Curve or Create Arc Curve toolbar buttons and then click on the viewer 
canvas for each point in the curve. Double click to end the curve object. Curve points can be 
modified after creation.


Adding Meshes 


Double click on the Create Spline Mesh toolbar item to specify the mesh size and other 
properties. Then single click the Create Spline Mesh toolbar item and click and drag on the 
view window to add a mesh to the scene. Mesh points can be modified in edit mode, as well 
columns and rows can be added and removed after creation. 


Spline mesh objects can also be conformed to curve object profiles using the conform menu 
items in the Tools menu.


Editing Objects 

Double clicking on an object will open an editor window for objects. Double clicking an object 
from the right hand object list pane to edit or right click and choose the edit menu item.


Hiding Objects 
Right click to hide or show objects in the object list pane on the right side of the window. 


Nesting Children 


In the scene object list items can be selected and dragged into other objects to become a 
child. Nesting can be used for organization and some special objects apply properties to their 
parent object for example the mirror plane object will mirror parent curve and mesh objects.
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Searching for Objects 

The Object Menu, Find Object menu brings up a dialog for searching for objects by name. 
Results will be displayed in the selection list on the right hand pane. Selecting items from the 
selection list will highlight them.


Saving and Exporting 

Saving native ADS files can be done from the file menu and exporting to some supported file 
formats are available.
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GCode Reference 

GCode is a machine instruction file format many CNC machines use for control including the 
Arma CNC Tube Notcher. There are many instructions but a subset used by the notcher are 
detailed here.


G1 - Linear interpolation. Instructs the control software to move in straight lines. 


X - Specifies position values along the X axis used by the Gantry.


Y - Specifies position values along the Y axis not used by the Arma Tube Notcher.

 

Z - Specifies position values along the Z axis used by the check rotation.


M3 - Start the plasma torch. 


M5 - Stop the plasma torch.


F - Specifies the motion speed. 
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Trouble shooting 

Torch is not activating 

Check that power is supplied and the connections are secure.


Torch is not cutting consistently 

Check that the metal being cut is clean. 


The cut parts are not the correct size.  

Calibrate the control software configuration on X and Z steps per inch. Move the gantry the full 
length to verify the movement is expected.
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